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1 Introduction
Graphics Plugins for Adobe Premiere Pro, Avid and Edius are available in this version. This guide 
only concentrates on workflows related to these plugins. For information about other supported 
Graphics Plugins, please go to the relevant version of the Graphics Plugin Administrator Guide.

1.1 Typical Workflow 
A typical workflow starting with scene and template design, and ending with video rendering and 
playout consists of the following steps:

A graphics designer creates a scene in Viz Artist.
The scene is either added as a template to a Viz Trio show or created as a template to use 
with Viz Pilot in Template Wizard.
An editor or a journalist edits a video using an NLE system.

Using Vizrt’s Graphics Plugin, the user can access and add graphics to the video.
Graphics properties can be edited using the graphics templates in either the Graphics 
Plugin Editor, Viz Trio, Viz Pilot or Viz Pilot Edge.

The video clip is rendered and saved to a shared file server or a Media Asset Management 
(MAM) system, such as Viz One.
Once the file is saved or posted to the MAM system, it can also be added to a playlist for 
playout on Viz Engine.

1.2 The Basic Graphics Plugin Workflow
Import video -> Import graphic -> Move graphic to video

While third party NLE workstations have different ways of importing and inserting graphics into a 
video, Graphics Plugin itself has the same interface across all third-party programs. See the 
respective sections below for more on using Graphics Plugin with specific programs.

http://docs.vizrt.com/viz-nle.html
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2 Using Graphics Plugin With Adobe Premiere Pro
This section explains the required steps on how to add Vizrt graphics to the timeline in Adobe 
Premiere Pro, and how to use stop points.

Adding Graphics Plugin
Stop Points

2.1 Adding Graphics Plugin
Create a new project or open an existing project in Adobe Premiere Pro.
Add a Transparent Video clip to the project:

In the Project panel, make sure that the Project tab is selected, and click the New 
Item button in the lower right corner.
In the menu that appears, click Transparent Video...

In the New Transparent Video dialog box that opens, select your Video Settings and 
click OK.
Drag the new transparent video clip to the Timeline.

Add Graphics Plugin to the project:
In the Project panel, click the Effects tab. (If the tab is not visible, select it from 
the Window drop-down menu bar).
Navigate to Video Effects > Vizrt > Graphics Plugin.
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Drag the plugin onto the transparent video clip in the Timeline.

Select the transparent video clip that holds the plugin.
Click the Effect Controls tab. (If the tab is not visible, select it from the Window drop-down 
menu bar).
Expand the Graphics Plugin option in the Video Effects list.
Click the Edit button to access the specified (done in the Configuration Tool) Graphics Plugin 
User Interface (Viz Trio, Viz Pilot Edge, Viz Pilot or Graphics Plugin Editor (Mac)) and to use 
Vizrt graphics.
Click the Setup... button (see image below) to access the Configuration Tool where you can, 
among many things, select your preferred Graphics Plugin User Interface. Go to 
the Configuration Tool section for more details.

Back in Adobe Premiere Pro, a graphics element has now been added to the transparent 
video clip.

Note: The NLE application will freeze when the Configuration Tool or the User 
Interface is open.


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10. Create another Transparent Video with graphics plugin and drag it to the timeline to have 
multiple graphics.

2.2 Stop Points
Stop points are added to a graphics scene to control the playout of the animation.  

Adding a graphic using the Graphics Plugin there is a stop point editor that allows you to adjust 
the length of the stop points.

The stop point editor is located in the Effect Controls tab > Graphics Plugin > Control:

Click and drag the small square next to the stop point you want to adjust:
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3 Using Graphics Plugin With Avid Media Composer
This section shows you how to add Vizrt graphics to the timeline in Avid Media Composer, and 
how to use stop points.

Adding Graphics Plugin
Editing Stop Points
Exporting Metagraphics

3.1 Adding Graphics Plugin
In Avid Media Composer, create a new project.
Import a video through the Source Browser window.
Click on the film icon on the item that you imported, and drag it into the Timeline window.

In the Project window, click on the Effect Palette tab (represented by a square purple icon), 
select Vizrt > Graphics Plugin, and drag it into a separate video track on the Timeline.

Open the Effect Editor by going to Tools > Effect Editor.
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In the Effect Editor window, under Graphics Plugin, click Editor to start importing graphics 
into Avid Media Composer. Viz Trio, Viz Pilot Edge, Viz Pilot or the Graphics Plugin Editor
(Mac) start depending on the specified Graphics Plugin User Interface in the Configuration 
Tool.
Click on Config to access the Configuration Tool. 

Check that you are in Effect mode in order to see graphics animations in the Preview 
windows.

Play the video clip or scrub the timeline to see the new effect.

3.2 Editing Stop Points
Stop points are added to a graphics scene to control the playout of the animation. Graphics Plugin 
contains a stop point editor that allows you to adjust the length of the stop points when adding a 
graphic.

To access the stop point editor open the Effect Editor: 

Go to Tools from the top menu and select Effect Editor in the drop-down list. 

Under Graphics Plugin, select the Toggle show/hide option.
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Click enable. A stop point editor appears at the bottom of the preview window:

Click the small square next to the stop point and drag to adjust it.
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3.3 Exporting Metagraphics 
Exporting sequences as metagraphics allows users to export metagraphics without burning 
graphics into the video. To enable, select the effect and tick the Metagraphics checkbox of the 
Vizrt Graphics Plugin.

When a user creates a new Vizrt Graphics Plugin effect, the default value for the Metagraphics
checkbox is read from a setting. This can be changed in Avid settings. 

Click on Config to access the Configuration Tool. 
Click the Advanced tab and in Settings view select Avid settings.
Set Metagraphics export as default to the desired value.

Note: As Avid Assistant is only available for Windows, exporting a sequence containing 
metagraphics is only available for that platform.



Note: Avid Assistant must be installed to export graphics to Viz One. See the Avid 
Assistant User Guide for more information.


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4 Using Graphics Plugin With EDIUS
This section shows you how to add Vizrt graphics to the timeline in EDIUS.

Accessing the Configuration Tool
Adding Graphics Plugin
Remote Rendering

4.1 Accessing The Configuration Tool
To open the Graphics Plugin Configuration Tool in EDIUS, go to Tools > Vizrt Graphics Plugin:

The Configuration Tool opens in a separate window where you can select your preferred Graphics 
Plugin User Interface, among other things. See Graphics Plugin Configuration Tool for more 
details.  

4.2 Adding Graphics Plugin
Before you can use Vizrt graphics, you must add Graphics Plugin to your project:

Create a new project or open an existing project in EDIUS.
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2. Right-click on a video track on the timeline and select New Clip > Vizrt Graphics Plugin:
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A graphics element appears on the timeline at the same time as the Graphics Plugin Editor
opens in another window.

After closing the Graphics Plugin Editor, you can double-click the graphics element on the 
timeline to open it again to change or edit the graphics. 

4.3 Remote Rendering
After setting up server-side rendering following the Configuring Server-side Rendering, you can 
remotely render an Edius project that contains Vizrt graphics.

4.3.1 Rendering the Project
Go to File->Export->Print to File (F11).
Check the XRE checkbox and select the configured XRE server.
Click Export. The XRE Monitor displays a new job and progress report.

Note: For information about the graphics, right-click the graphics on the timeline and 
select Properties....


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See also

Configuring Server-side Rendering on the Graphics Plugin Admin Guide.

http://docs.vizrt.com/viz-nle.html
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5 Configuration Tool
The Configuration Tool is the same for all applications. This section describes the UI and its 
options.

Reset All: Resets all settings to default (factory settings).
Performance: Opens the Performance Tester.
OK: Saves the current configuration.
Cancel: Cancels all changes and closes the Configuration Tool.
Help: Opens the Graphics Plugin user guide.

The General tab is selected by default with the following settings:

Render using:
Specific Viz Engine or Connection Broker: Specify one of them for rendering. 

Media Sequencer: Specify the Media Sequencer.

A description of configurable settings under the Advanced tab, based on the Settings view 
selected, follows below:

Note: The Help button is not shown for Mac users. To access documentation on a 
Mac, go to help in the menu bar.



Info: Connection Broker is a separate component that acts as a load-balancer for multiple 
Viz Engines. It's suitable for big installations. 


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Important
Graphics Plugin
Viz Engine
Editor Settings
Startup Variables
Shared System Settings

5.1 Important
Shows the most important settings needed to run Graphics Plugin:

Viz Engine Host: Sets the hostname or IP address of the Viz Engine renderer.
Viz Engine Use Connection Broker: See Connection Broker in the Graphics Plugin 
Administrator Guide.
Viz Engine Connection Broker host: Sets the host of the computer running the connection 
broker, see Connection Broker in the Graphics Plugin Administrator Guide.
Media Sequencer Host: Sets the host of the computer running the Media Sequencer service.
Graphics plugin User Interface: See Graphics Plugin User Interfaces.
Viz Engine Network compression: See Network compression under Viz Engine below.
Viz Trio NLE Host: Defines the hostname of the machine running the Viz Trio NLE. 
Typically localhost.
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Viz Pilot NLE Host: Defines the hostname of the machine running the Viz Pilot NLE. 
Typically localhost.

5.2 Graphics Plugin

User Interface:  Sets the interface to use for selecting graphics templates. 
Templates using the same scene but opened from Viz Trio, Viz Pilot or Viz Pilot Edge are 
different entities. Once an editor is set and used to add a graphic effect to the timeline, the 
effect is also bound to that editor. To create an effect with a template from another editor, 
the old effect must first be deleted, a new editor configured, and then a new effect created.
Log level:  Set the log level to provide an error report to Vizrt. Only do so when you need to 
make a report, as this slows down the plugin. See the Log Files section in the Graphics 
Plugin Administrator Guide for more information on log file locations.

None: Logs errors only, which is the default behavior.
Report: Generates dated log files. In almost every case, the log files will include 
enough information to allow Vizrt to identify the issue. 

Note: Settings view contains all settings that are separate and only apply the Graphics 
Plugin. These are not application-specific settings, such as those that apply Viz Engine and 
Graphics Plugin Editor.


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Extreme: Generates a very large amount of logging information.
Log directory:  Use this setting to override the default logging directory. See the Log 
Files section in the Graphics Plugin Administrator Guide for more information on logging.
Should log fields/frames:  Enables the plugin to dump all frames and fields it renders to the 
file system, allowing the user and Vizrt support to identify issues related to the graphics. 
Files are dumped in a sub-directory of the Log directory.
Color correction:  Enables broadcast-safe colors. Set cap-601 to cap high and low values 
directly to get 16-235. Set linear-cap-601 to perform a linear recalculation of the data to 
16-235. The default value is None.

Premultiply alpha:  Configures whether the plugin pre-multiplies alpha when rendering. In 
some cases, the Viz Engine has already multiplied the color channels with the alpha channel.
Anti-aliasing:  Controls whether requests for small frame sizes should be anti-aliased on the 
Viz Engine.
Untrusted SSL: Controls whether HTTPS servers with self-signed certificates should be 
trusted. 

5.3 Viz Engine
The Viz Engine Settings view is shown below:

Note: The background videos (or images) should also be at safe levels to prevent 
darkening on semi-transparent pixels.


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Host:  Sets the hostname or IP address of the Viz Engine renderer.
Use Connection Broker:  Enables Graphics Plugin to connect to the Connection Broker for 
graphics rendering.
Connection Broker host:  Sets the hostname or IP address of the Connection Broker (see 
Connection Broker).
Network compression: Sets the compression level. It is recommended to use no compression 
on gigabit networks, and compressed formats on slower networks (e.g. 100mbit). The 
default value is RLE.

No Compression: Sends send all frames across the network uncompressed (for gigabit 
networks).
PNG (Portable Network Graphics): a lossless compression format.
RLE (Run-length Encoding): a lossless compression format. RLE is only supported by 
Viz Engine 3.2.2. and later versions (see Software Requirements).

Prefetching:  Prefetching, also known as caching, greatly increases the rendering speed 
when using start to stop rendering, like Pinnacle's yellow slices, or Avid's pre-render effect 
mode.
Failsafe mode is off.
Default value is on.
Prefetch size:  Use this setting to indicate how many frames or fields the plugin should pre-
fetch. A higher number improves start to stop rendering (pre-render) performance but 

http://docs.vizrt.com/graphics-plugin-guide/2.2/Connection_Broker.html
http://docs.vizrt.com/graphics-plugin-guide/2.2/Software_Requirements.html
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reduces the scrub performance. Note that this option is only available if pre-fetching is 
enabled. Prefetch values above 50 are ignored. Default value is 20. 
Network timeout:  Controls how long Viz Engine connections wait for replies. Unless network 
measurements for the Viz Engine have been performed, this setting should not be changed. 
Default value is 45 sec.
Information timeout: Controls how long Viz Engine waits for a reply for initial 
information.  This setting should not be changed unless network measurements of the Viz 
Engine have been performed. 
Network cleanup:  Controls how long the plugin waits after last use before cleaning up loose 
connections to the Viz Engine. This should not be changed unless the actual use of the 
plugin has been measured. Default value is 8 mins.

5.4 Editor Settings
Toggle settings view to display settings for either the Graphics Plugin Editor, Viz Trio, Viz Pilot or 
Viz Pilot Edge. Common settings are presented first, followed by editor-specific settings:

Host/URL: Sets the hostname or IP address (URL for Viz Pilot Edge app) of the machine 
running the Graphics Plugin Editor, Viz Trio or Viz Pilot.
Network timeout:  Controls how long connections to Graphics Plugin Editor wait for replies. 
This should not be changed unless network data for the Graphics Plugin Editor has been 
measured. Default value is 90s.  
Grace period:  Controls how long Graphics Plugin waits for the editor to start everything 
without interruptions. Default time is 2s.

Note: Host port number restrictions when previewing templates on Editor - Viz 

engine port 50007  or 50107  must be used in order to preview templates on 

Graphics Plugin Editor, Viz Trio, Viz Pilot or Viz Pilot Edge. These ports connect to 

preview ports 50008  and 50108 , respectively. See Network Requirements in the 

Graphics Plugin Administrator Guide for port numbering information.


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5.4.1 Viz Trio NLE

Executable: Name of the editor's executable file. Can be changed if a different filename is in 
use. Default value is trionle.exe.
Options: The exact command line options string passed to the editor’s process at 
startup. For more information on command line options, see the Startup Variables section.
Shared folder: Shared path used for temporary files during import of Viz Trio shows. Both 
the Graphics Plugin and the external Viz Engine should have full access to this folder.
Shared folder for Viz Engine:  Shared path as seen from the Viz Engine machine, must refer 
to the previous setting. Only needed if the external Viz Engine uses a different path (such as 
a mapped network drive) for the same folder.
Drive remappings: Semicolon-separated list of drive remappings used during import of Viz 
Trio shows. These will cause associated files of the specified file types to be unpacked to a 
different drive letter rather than stored in the *.trioshow file. Each mapping is in the form 
wildcard=driveletter.
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5.4.2 Viz Pilot NLE

Executable: Name of the editor's executable file. Can be changed in case another filename is 
in use than the usual. Default value is VcpAxNle.exe.
Options:  The exact command line options string passed to the editor’s process at startup. 
For more information on command line options, see the Startup Variables section.
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5.4.3 Viz Pilot Edge

Viz One Username: The username to log in to Viz One. 
Viz One Password: The password to log in to Viz One.
Graphic Hub Username: The username to log in to Graphic Hub.
Graphic Hub Password: The password to log in to Graphic Hub.

When using Pilot Edge in a Regular Browser (Chrome/Firefox/IE)
The popup below appears if Pilot Data Server is configured to use a Viz One server, or the user has 
manually specified a Viz One server via URL parameters (by appending "?vizone=hostname" to the 
end of the URL), but no default password has been configured in Pilot Data Server settings. If the 
username and password are not entered, the server's media will be unavailable for the duration of 
the session and will not be visible while browsing Pilot Edge.
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5.4.4 Graphics Plugin Editor
VOS image search: URI template for image search from Object Store, a component of Viz 
Pilot. This requires a Viz Pilot Data Server. Since it's a URI template, there must be a 
placeholder in the text you enter, indicated by curly-brackets, which is replaced by specific 
search terms, for example: http://vcpserver.example:8177/vos/search?q=\{query}.

Pop-ups are not shown when Pilot Edge is used via the NLE Editor: Any authentication 
request therefore always fails silently. This can be remedied by filling in the Username and 
Password fields. If the server requests additional authentication for either Viz One or 
Graphic Hub, the above fields are used. However, if the server does not request Viz One / 
Graphic Hub credentials, either because valid credentials already exist server side, or 
because no Viz One / Graphic Hub is configured, these fields are silently ignored.



http://vcpserver.example:8177/vos/search?q=
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5.4.5 Adobe/Avid/Edius* Settings
* depending on your NLE application.

Still image playback: Only render still images to increase performance when low-quality 
frames are requested. This affects scrubbing and playback. A high-quality frame will 
eventually be rendered upon scrubbing, which shows the correct representation of the 
graphics after rendering. 
Disable multithreaded rendering: Multithreaded rendering can cause performance issues 
when too many threads try to render at the same time. If rendering is unusually slow this 
may be set to true. You must restart the NLE application after changing this setting.

5.4.6 Searching for Object Store Images 
Create a sequence.

Note: The option to Disable multithreaded rendering is only available for Adobe 
Premiere Pro and Avid Media Composer.


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Add a clip to the sequence.
Drag the Graphics Plugin effect to the sequence.
Double-click the effect, and select the Controls tab at the top of the screen.
From the Controls panel, click Graphics Plugin Config.
In the Graphics Plugin Configuration Tool window that opens, click the Advanced tab.
From the Settings view list, click All settings.
Locate the VOS image search, and set the path to your Object Store.
Click OK.
Back in the Controls panel, click Graphics Plugin Editor.
In the Graphics Plugin Editor window that opens, select a show and then a template 
containing an image field.
From the Information fields list, select the field that contains the image.
From the window that opens, click the Search tab.
Type a search string that matches your preferences in the search field.
From the list of images on your app server, select the one you prefer.
The image is being updated both as a thumbnail in the Information fields list and in the 
preview window.
Click OK to return to the sequence view.

5.5 Startup Variables
Options are used as variables for the actual value set for the plugin. The options can be used as 
part of an editor’s startup options.

The following options are available and configurable:

MSE_HOST: References the active Media Sequencer host.
Example: -mse MSE_HOST

LOG_PATH: Refers to the currently used Plugin log directory.
Example: -logfile-path "LOG_PATH"

5.6 Shared System Settings
This section covers the shared settings feature that is available to Windows users in the system 
registry.

Note: The startup options are only valid for NLE editors on Windows.
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The system stores the settings in a per-user directory, for example under C:\Documents and 
Settings\<username>. Placing the same file in a shared directory allows multiple users to use a 
standardized setup overriding per-user settings.

By adding a Windows registry entry with a path to the master configuration file, the settings in that 
file take precedence over the default values for the various settings, but the individual settings 
that the user changes in the Graphics Plugin configuration tool take precedence over the master 
configuration file.

HKEY_LOCAL_MACHINE/SOFTWARE/[vizrt]/NLE/AVX2/SettingsDir

Given a particular setting, the following rules apply:

If a setting has been set using the Graphics Plugin configuration tool, that value is used.
If it has a value in the master configuration file, that value is used.
The default value for the setting is used.

5.6.1 Adding a Shared System Setting
Start the Graphics Plugin configuration tool.
Configure Graphics Plugin using the configuration tool.
Save and exit the configuration tool.
Find the file vizplugin.xml in the current user's Application Data folder.
Copy the file to the designated shared location.
Set up the SettingsDir registry entry to point to the shared directory location where the 
copied file was placed.

Note: Shared settings do not apply to Mac users.
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5.7 Performance Tester
The Performance Tester is used to test different configurations. It tests Graphics Plugin directly 
and how it performs on the network, and rendering. It also shows how quickly Graphics Plugin 
returns graphics to the NLE system - the raw speed of the plugin.

Results table: Shows a table of results displaying the protocol tested, prefetch size, time and 
frames per second achieved.
Viz Engine: Sets the Viz Engine host to be used for testing.

Note: The Performance Tester is accessed by clicking the Performance button at the lower 
left of the Configuration Tool.



Note: The time it takes to fill the NLE system's frame buffer and the time used between 
each request for frames to the NLE system are not tested. It's therefore recommended to 
test the NLE system once Graphics Plugin has been tested and found to be working 
satisfactorily.


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Image protocol: Sets the parameter for how to transfer the graphics over the network. Select 
one or multiple options and choose between RLE, PNG and No compression.
Prefetch size: Sets the pre-fetching that will be tested. Available options are 5, 10 or 20
frames or fields.
Scene name: Sets a particular scene that can be loaded and tested (for example, 02_GFX/
VizNLE/1000).
Clip length: Sets the length of the clip that is to be rendered. Five or ten seconds are good 
starting points to check the rendering time.
Pause time: Sets the pause in milliseconds between renders, that is the time that an NLE 
system uses to process the previous data. This would be lower for SD than for HD. It's 
recommended to try other values between 0 and 100 ms+ to see how this affects the 
network use. For more information, see Fine-tuning the System in the Graphics Plugin 
Administrator Guide.
Video mode: Sets the Viz Engine video mode to either:

1080i 50 FPS
1080i 60 FPS
720p 50 FPS
720p 60 FPS
PAL
NTSC

Run tests: Tests the current settings configured for the plugin with the clip length and pause 
options set. This is useful when performing tests with concurrent users.
Test summary: Shows a report of problems and various statistics.

Note: Once the settings that provide optimal results are found, they can be manually set in 
the Viz configuration tool and tested with the NLE system itself.


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6 Graphics Plugin User Interfaces
This section describes user interfaces that can be used with Graphics Plugin. The NLE version of 
Viz Trio is bundled with the Graphics Plugin installation. The Graphics Plugin Editor is the user 
interface for Mac machines since Viz Trio is not supported. Viz Pilot Edge can be used by providing 
the URL in the Configuration Tool. Viz Pilot can also be used as the user interface if it's installed on 
your computer.

Click the Edit button in Adobe Premiere Pro, or the Editor button in Avid to open the user interface 
selected in the Configuration Tool in a separate window. 

This section contains more information about how to use the various user interfaces:

Viz Trio
Viz Pilot Edge
Viz Pilot
Graphics Plugin Editor

6.1 Viz Trio
 If Viz Trio NLE has been selected in the Configuration Tool, the following Viz Trio window opens:

Select a graphics template by double-clicking it in the Page List. The graphic will open in the Side 
Editor where it can be edited and previewed in the window below:
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When your graphics is ready to be used in your NLE system, click the Save As NLE button to avoid 

overwriting the page: 

The graphics will be given a new Page ID.

Click Save and render in NLE  . Viz Trio closes and the graphics appear in 
your NLE system.

For more information on how to use Viz Trio, please see the Viz Trio User Guide.

6.2 Viz Pilot Edge
If Viz Pilot Edge has been selected in the Configuration Tool, the following Viz Pilot Edge window 
opens where the user can browse for graphics.

Click Find Graphics.

http://docs.vizrt.internal/viz-trio.html
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Select a graphics element or a template at the bottom of the dialog that appears by double-clicking 
it.
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The graphics open in a new window where you can edit the content of the graphics in the fill-in 
form to the left and preview the output at the right in the application. When your graphics is ready 
to be used, click OK. Viz Pilot Edge closes and the graphics appear in your NLE application.  

Note: If you edit a template or data element and then attempt to open a different one, a 
dialog appears which allows you to save the first template or element. Creating a new data 
element cannot be done in Viz Pilot Edge through the NLE application, but must be done 
separately in Viz Pilot Edge in a browser.


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For more information on how to use Viz Pilot Edge, please see the Viz Pilot Edge User Guide.

6.3 Viz Pilot
If Viz Pilot NLE has been selected in the Configuration Tool, the following window opens where the 
user can browse for templates and data elements.

The left side of the window lists available templates in the database while the right side lists 
available data elements (saved templates). 

https://docs.vizrt.com/viz-pilot-edge.html
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Select a template or element by double-clicking it and edit the content of the graphics to the left 
and preview the output at the right in the application. 

In order to use a template subsequently, you must save it as a data element by clicking Save 
As, giving it a name and clicking Save as new. This closes the Viz Pilot NLE application and the 
graphics element appears in your NLE application.

If you are using an already existing data element click Save to use the data element as is or to 
overwrite any changes. Click Save As to create a new data element. In both cases, the Viz NLE 
application closes and the graphics element appears in your NLE application.
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For more information on how to use Viz Pilot, please see the Viz Pilot User Guide.

6.4 Graphics Plugin Editor
This section describes the Graphics Plugin Editor’s interface which is only available for Mac users. 
If you're using Viz Pilot Edge or Windows with Viz Pilot or Viz Trio, please see the relevant sections 
above.

This section covers the following topics:

Menu Options in Graphics Plugin Editor
Information Fields in Graphics Plugin Editor
Preview Settings in Graphics Plugin Editor

https://docs.vizrt.com/viz-pilot.html
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6.4.1 Menu Options in Graphics Plugin Editor
The following menu options are unique to the Graphics Plugin Editor. Other options are generic 
options provided by the operating system.

Page
Save Page (CMD + S): Saves a page back to the Media Sequencer.
Next tabfield (CMD + DOWN ARROW): Selects the next tabfield.
Previous tabfield (CMD + UP ARROW): Selects the previous tabfield.

Show
Import Trio XML Archive: Imports an exported Viz Trio archive. The import recreates 
the exported show on the connected Media Sequencer.
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6.4.2 Information Fields in Graphics Plugin Editor
The Graphics Plugin Editor supports the most common control properties; however, it is only 
possible to input text, change numerical values, select images, geometries, fonts and materials.

There is no support for input of boolean values, editing of lists and tables or scrolls. However, the 
editor can use and render Viz Trio pages made using a regular Viz Trio even though they have 
these field types.

6.4.3 Preview Settings in Graphics Plugin Editor
The following may be set for the preview:

Safe area: Shows the defined safe area configured by the current Viz Engine.
Title area: Shows the defined title area configured by the current Viz Engine.
Key: Shows the graphics’ key signal.
Bounding boxes: Shows the bounding boxes for the graphical elements in the scene.

Note: When performing an import you should always make sure that the scenes are 
available to the connected Viz Engine.


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7 Scene Design
When designing scenes in Viz Artist that are to be used together with Supported NLE Systems, you 
must follow specific design conventions for the output to render correctly.

Please be aware of the following when designing for the Graphics Plugin workflow:

Key
Stop Points
Effect Plugins
Transition Logic
Lift and Extract

7.1 Key
When designing a scene, a key signal must be added to the scene for the graphics to blend 
correctly with the video.

7.1.1 Adding a Key Signal
Add the Key plugin to one or more containers in the scene.
Enable Auto Key under the global scene settings.

7.2 Stop Points
If you are using stop points when designing a scene, they must be added to the directors at the 
root level of the Stage.

In a scene that contains only one stop point, the in-animation takes place on the left side of the 
stop point in the Stage, while the out-animation is visualized on the right side. The stop point is 
automatically converted to a pause point, and, if needed, is also stretched to make the entire 
animation (in, pause, and out) match the length of the graphics element in the NLE timeline.

7.2.1 Stretching Stop Points
The stop points in a scene are automatically stretched so that the animation matches the length of 
the graphics element in the NLE timeline.

Example 1
If an in-animation of three seconds and an out-animation of four seconds is stretched to ten 
seconds in the NLE timeline. The in-animation is shown for three seconds, then the stop point 
between the in and out-animation that's stretched is shown for  three seconds, and finally the out-
animation is shown for four seconds (totaling ten seconds).

http://docs.vizrt.com/graphics-plugin-guide/2.2/Supported_NLE_Systems.html
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Example 2
If the animation in example 1 above is shortened to five seconds: the in-animation is shown 
for three seconds, the pause point is skipped, and the out-animation is reduced to two seconds.

Multiple stop points are stretched evenly unless you have a modified stop point. If the animation 
contains two stop points and is stretched to 17 seconds, then the in-animation is shown for three 
seconds, the first stop point for five seconds, the second for another five seconds, and the out-
animation for is lastly shown for four seconds. 

7.2.2 Directors and Stop Points in Viz Artist
Stop points that are used to pause and stretch animations must be placed in directors at the root 
level of the Viz Artist Stage. Stop points that are placed in sub-directors (not at the root level) are 
ignored by the NLE system.

Animations that are paused and stretched must also be placed in directors at the root level of the 
Viz Artist Stage. Any animations in sub-directors are not stretched, such as looping background 
animations and similar, should be placed here. These animations are played out continuously, 
regardless of the stop points in the root containers.

7.2.3 Sound and Stop Points
There is no support for embedded sound effects in graphics being used in the Graphics Plugin 
workflow. Sound that is embedded together with graphics is based on the timeline used for the 
graphics, and there is no good and general way to stretch sound.

7.2.4 Video
There is no support for embedded video clips in graphics being used in the Graphics Plugin 
workflow. 

7.3 Effect Plugins
Effect plugins, such as RFxSmoke, work in such a way that particles are emitted from a certain 
point and then moved in a random order in a direction until they eventually fade away. The output 

Note: If you modify a stop point, any attempt to resize will only affect the rightmost stop 
point, if possible. 



Note: When making a scene for NLE, make sure that no empty directors are left in the 
scene. The main director that contains the in and out animation must be the very first 
director on top of the list of all directors. This main director must be on top and contain 
the stop point pilot1. If an empty director is left on top no output will be displayed.


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of this random particle movement may be distorted when played out as part of the Graphics Plugin 
workflow. It's therefore recommended to use such effects with caution when designing for NLE.

7.4 Transition Logic
It's possible to work with Transition Logic scenes with certain limitations. Graphics templates can 
be modified and sent to air using the normal NLE workflow. A template that contains multiple 
elements, such as a banner, logo, and a lower third, can be animated to the various in and 
out states so that it matches the timing of the graphics event in the timeline.

7.4.1  Transition Logic Scene Design Limitations
There is no support for graphics that are dependent on states of other graphics elements. 
For example, a normal Transition Logic scene can be designed to have a logo taken on air in 
the lower part of the screen and shift to the upper part of the screen when a lower third is 
taken on air. To achieve this type of behavior: use Viz Trio or Viz Pilot’s Template Wizard to 
create a combination template to control the required layers, such as bug, clock, lower third, 
OTS, and so on.
There is no support for multiple graphics stacked together, so-called in-to-in or back-to-
back animations. For example, when showing two instances of a lower third straight after 
each other on the timeline, it's not possible to keep the backplate from object number one, 
and simply update the editable variables, such as the name of the interview objects. Instead, 
the first element must be animated out, and then the second element must be animated in.

7.5 Lift And Extract
When using Viz Pilot as your Editor, Lift and Extract lets you remove a portion of a clip from the 
timeline. This is usually set by the mark-in and mark-out points.

Lift removes a portion of a clip while leaving the interval duration between the mark-in and 
mark-out points.
Extract removes a portion of a clip, but does not leave the interval (cutting the portion of the 
clip out completely).

Although Lift and Extract modify the clip, no frames in the graphic are skipped. The portions of 
the clip before mark-in and after mark-out are entirely separate, and the graphic is also split.

7.5.1 See Also
Viz Artist User Guide sections on Transition Logic
The Viz Trio User Guide section on Combination Templates

https://docs.vizrt.com/viz-artist.html
https://docs.vizrt.com/viz-trio.html
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